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                                                            CLASS: VI 

                                          

                                       ENGLISH LESSON PLAN (13/07/2020 – 18/07/2020) 

                                               

                                         GRAMMAR : SUBJECT & PREDICATE 

                                         

                                    WRITING SKILL: NOTICE WRITING ( INTRODUCTION). 

 

 

Learning Objectives: 

 
1. The learner will understand the difference between the subject and the predicate. 

2. The learner will identify the subject and the predicate in a sentence. 

3. Students will be able to analyse any NOTICE shown to them on the basis of the 

knowledge imparted. 

4. They will be able to frame notice about any event. 

5. Students will be able to use appropriate style and format to write a NOTICE 

effectively 

 

 

URL: https://www.youtube.com/watch?v=r3sTXXD7bc8 

Every sentence has two parts- Subject and Predicate. 

Subject refers to that part of the sentence that we are speaking about. The term “Subject” 

means something which has more importance. Subject can be a person, place, thing, or an 

animal. 

Predicate refers to the part of sentence that tells about the Subject. The term “Predicate” is 

derived from a Latin word which means declared. It contains the Verb and all words 

supporting the Verb. So Predicate declares something about the Subject in a sentence. 

For example, 

1. Children love ice cream. 

 In this sentence, we are talking about the children and giving more importance to 

them. So “children” are the Subject in this sentence. The sentence says that the 

children love ice cream. So “love ice cream” is the Predicate in this sentence. 

 

2. I am feeling very thirsty. 

Subject-  I 

Predicate – am feeling very thirsty 

 

                              Grammar Assignment ( Subject and Predicate) 

Q.1 Identify the subject and the predicate in the following sentences. 

1. The sun was shining brightly. 

2. The dogs were barking loudly. 

https://www.youtube.com/watch?v=r3sTXXD7bc8


3. The pretty girl was wearing a blue frock. 

4. My younger brother serves in the army. 

5. The man and his wife were working in their garden. 

6. My mother and my aunt are trained classical dancers. 

7. You don’t have to wait for me. 

8. We will no longer tolerate this. 

9. The little tree was covered with needles instead of leaves. 

10. A rich merchant was passing by the shoemaker’s window. 

 

 

 

Q.2 Identify the highlighted words as Subject or Predicate:  
 

 

Q1. The boy ate the apple. 
 

 

Subject 
 

 

Predicate 
 

 
 

 
Q2. I need help with this math problem. 
 

 

Subject 
 

 

Predicate 
 

 
 

 
Q3. Next week my grandmother is coming from Korea. 
 

 

Subject 
 

 

Predicate 
 

 
 

 
Q4.. My favourite month is May. 
 

 

Subject 



 

 

Predicate 
 

 
 

 
Q5. May is my favourite month. 
 

 

Subject 
 

 

Predicate 
 

 
 

 
Q6. Our homeroom is having a pizza party tomorrow. 
 

 

Subject 
 

 

Predicate 
 

 
 

 
Q7. Football is played in every country in the world. 
 

 

Subject 
 

 

Predicate 
 

 
 

 

 
Q8. Yasmin yawned. 
 

 

Subject 
 

 

Predicate 
 

 
 

 
Q9. My expensive new watch has stopped. 
 

 

Subject 
 

 

Predicate 
 

 
 

 
Q10 Sitting on the roof of my house was a huge black bird. 
 

 

Subject 
 

 

Predicate 
 

 
 

 



 

                                                    

                                            Notice Writing   ( Introduction) 

 

INTRODUCTION: 

A Notice is information regarding an important event that is about to happen. It is publicly 

displayed - a kind of information for others to know and follow. The notice must contain 

complete information. It should be written in a formal tone. 

 

A notice should contain all the necessary details such as: 

1. Name of the issuing agency (school, institution etc) 

2. Subject and date of issue/release of the notice 

3. The notice must answer the question: WHAT, WHERE, WHEN, WHY, HOW. 

4. State clearly the event. 

5. Mention the name of the body/ organisation – organising the event. 

6. Authorized signatory: Name and signature. 

 

Important points: 

1. Use formal tone and register. 

2. Always put the notice in a box. 

3. Do not exceed the Word limit of 50 words 

 

 

                                                 

 

                                                      Format of Notice Writing 

 

 

 



 

           
 

 

                                             SAMPLE OF NOTICE WRITING: 

 

1. You are Varun/ Rita, the music secretary of Modern School, Barakhamba Road. Your 

school is hosting the 6th Inter-school Music Carnival. Write a notice inviting the 

students for the audition in the school auditorium. Put the notice in the box. ( Word 

limit: 50) 

 

                     

                                       Practice Questions: 

Q.1 You are Arush/ArushiTandon, the Head Boy/Girl of CPH Public School. Your school is 

hosting an Inter-House English Poetry Competition. Draft a notice to be put up on the school 

notice board informing students about it. Invent all the necessary details.  



 

Q.2 You are Ashish Jain of VI-C Exford Public School, Gaziabad. While playing in the 

basketball court, you lost your Science practical register. Drat a notice, regarding the same 

and announce a suitable reward to the finder.  

 

 

 

ACTIVITY: 

Question: Design a poster on the topic ‘ The most exciting or effective learning 

environment would be…… ( Give an eye-catchy slogan and design it neatly.) 

 

Class 6 Hindi  

https://youtu.be/1ellheHK_yY - शशशश शशशशश 

Note- please refer to the above given link to study the 

chapter 

__________________________________________________

___________ 

शशशश शशशशश 

 शशशश शशशशश शश शशशशशशश 

दद दद दद दद दददद ददददद दद ददद ददद दददद दद 'दददद' दददद दद, ददददद 

ददद द ददद दददद ददददद ददद           ददद दद ददद दद दद दददद दद- 

दददददद दद दददददददद दद दददददद ददद दद 'दददद' दददद ददद 

दददद- दददददद, ददददद, ददददददद, द, ददद, दद, दददददद, ददद, दददद, 
दददद 

 

 शशशशशश शश शशशशशशशश शशश शशशशशश शश शशशश शशशश शशश 

1. दददद दद दददद दद 

2. ददददद दद दददद दद 

3. दददददददद दद दददद दद 

4. ददददद दद दददद दद 

https://youtu.be/1ellheHK_yY


1. शशशश शश शशशश शश शशशश शश शश शशश शशशश शशश 

दददद – दददददद दददद, ददददददद दददद 

दददददद दददद – ददद दददददद दद ददद दददद दददददद दद दद ददद दददददद 

दददद दददद ददद; दददद-दद, ददद, दददद, दददद द 

ददददददद दददद – ददद दददददद दद ददद दददद दददद दददददद दद ददद 

ददददददद दददद दददद ददद;     दददद-ददद, ददद, 
दददददददद 

2. शशशशश/शशशशशश शश शशशश शश शशशश शशश-शशशशशश शश शशशश शश शश 
शशशशशश शश शश शशशशशश शशश शशशशशश शशशश 

 दददददद दददद 
 ददददददद दददद 

शशशशशश शशशश – ददददद दददद ददददददददद दद दददद दददददद दददद, ददद, 

दददद ददद दद दददद ददददद (दददददददद) द दददद ददद 
दददददद दददददद दददद दददद दददद दददददद दददद दद ददद ददद दददद 
दददद 

 दददददद 
 ददददददद 
 दददददद 
 दददददद 

शशशशशशश शशशश – द + दददददद दददद दददददद दददददददद द दद, ददद 

दददद दददददद दददद, ददद, दददद ददद दद दददद ददद दददददददद दददद 

दददद दद, दददददद ददददददद दददद दददद दददद दद ददद दददददद दद दददद 
दददद 

 दददददददददददद 
 ददददद दददद 
 ददददददद दददद 
 ददददददददद दददद 

3. शशशशशशशश शश शशशश शश शशशश-शशश 
दददददददद दद दददद दद दददददद दद ददद ददददद ददद दददद दददद दददद 

 ददददद दददद 
 ददददद दददद 
 दददद दददद 



 दददददद दददद 

(i) शशशशश शशशश – ददददद दददद ‘ददद + दद’ दददद दद ददददद ददद ददद 

ददद दद दददद दद दददद ददद दद दद दददद दद दददद दददद दददद ददददद 
ददददददद दद दद दददद दद ददददद ददद दददद दददद दददददददद दद 

दददददद ददद ददद दददद ददद, दद ददददद दददद दददददद दददद   

                दददद-ददददद, 

दददददद, दद, ददद, दददद, दद दददद 

(ii) शशशशश शशशश – दद दददद ‘दद + दद’ दददद दद ददद ददद दददद दददद दद-
दददद दददद दददद दद दददद ददददददद दददददद दद ददद ददद ददद ददददद 
दद ददद ददददद दददद ददद दददददद दददद दददद     

          दददद-ददद, ददद, दददद (दददद) दददद (ददददद) दद 

(दददद) ददद (ददददद) दददद (ददददद) दददद 

(iii) शशशश शशशश – ‘दददद’ दददददद ददद ददद दददददददद दद दददद दददद 
दद ददददददद ददददददददद दद ददद दद दददददद दद दददद दद ददद दद दददद 

                   

दददद- दददददद, दददद, दददद, दददददद, ददददद दददद 

(iv) शशशशशश शशशश – ददददद ददददद दद दददददद दद ददददद ददद दद दददद 

‘दददददद’ दददद दददददद दददद          दददद-दददददद, दददददद, 

दददददद, ददददद, ददददद, दददद, ददददद, ददददद, दददद, ददद, ददद, दददद, 

दददद, ददददद, ददददद, दददददद, दददद दददद 

ददददद 
दददद 

ददददद 
दददद 

ददददद ददद 

दददद ददद 

ददददद दद 

दददद ददद 

ददददद ददद 

ददददददद ददद 



ददददद 
दददद 

ददददद 
दददद 

दददददद ददद 

ददद दददद 

दददद ददद 

ददददद दददद 

दददद ददददद 

दद दद 

दददददद ददद 

दददददद ददद 

ददददददद ददददद 

दददद दद 

दददददद दददद 

 

4. शशशशश शश शशशश शश शशशश शशश – शशशशश शश शशशश शश शशशश-शशश शशश 
शशशशशश शश शशशश शशश 

 दददद दददद 
 ददददद दददद 
 ददददददद दददद 

(i) शशशश शशशश – दद दददद दद दददददद दद दददद ददददददद, ददददद ददददद 

दद दददददद ददद दद ददद दददददद दददद ददद द ददद ददद, दददददद दददद 



दददद दददद दददद दद दददददद दद ददद दददद दद दददद ददद दददद दददद 

दददददद दददद ददद दददद दद दद दददद ददददददद दद दददद ददद;   

                 दददद-

ददददद, दददददद, दददद, दद दददददददद 

(ii) शशशशश शशशश – दद दददद दद दददददद दद ददद दद दददद दददद ‘ददद’ दद 

दददद दददद दद ददददद ददद दद दददददद दद दददद दद ददद ददद दददद, दद 

दददददद दददद ददद-ददददद दददद दददददद दददद दददद दददददद ददद दद 

दददद ददद;                          दददद-ददददददददद, दददददद, दददद दददद 

(iii) शशशशशशश शशशश – दद दददद दद दद दद दद दददद दददददद दद ददद दद 
ददद ददद दद दददद ददददद दददद दददददद दद ददददददद दददद दददददद 

ददद;                   

दददद- (द) दददद = ददद (ददददद) ददददद दददददद ‘ददद’ ददददद दददद 

ददददद दद ददद ददद ददद दद ददददददद दददद दददद दददद + ददद = 

दददददद (दददद ददददददद दददददद ददद) 

 

शशशशशशशशशश शशशशशश 

1. दददद दददद ददद 

(i) दददददद दद दददद दद 

(ii) दददददद दद दददददद ददद दद 

(iii) ददददद ददद दददददद ददद दद दददददद दद 

(iv) दद ददद दद 

2. ददददद दद दददद दद दददददद दद ददद ददददद दददद ददद? 

(i) दद 

(ii) ददद 

(iii) ददद 

(iv) दददद 

3. ददद दद दददद ददददद दददद दद 

(i) ददददददद 

(ii) दददददद 

(iii) दददद 

(iv) दददद 



4. दददददद दद दददद दद दददद दददद ददद 

(i) दददद 

(ii) दद 

(iii) ददद 

(iv) ददद 

5. ददददद दददद दददद ददद 

(i) दद ददददददद दद ददद ददददद ददददद ददद ददद दददद 

(ii) दद ददददद दद ददद ददददद ददददददद ददद ददद दददद 

(iii) दद दददददद दददददद दद ददद ददद दददद 

(iv) दद दद दददददद दद ददददद दददद दददद 

6. ‘दददददद’ दददद दददददददद दद दददद दद ददद ददद दद दददद दद ? 

(i) ददददद 

(ii) दददद 

(iii) ददददद 

(iv) ददद 

7. ददददद ददद दद दददद दददद दददद दद? 

(i) ददददददद 

(ii) दददद 

(iii) दददददद 

(iv) ददददददददद 

8. दददददददद दद दददद दद दददद ददददद दददददद दद दददद ददद? 

(i) ददद 

(ii) दद 

(iii) ददद 

(iv) दददद 

9. ददददद दददददद दद ददददददद दद 

(i) दद दददद दद ददददद दद दददददद दददद दददद 

(ii) ददददद दद दददद ददददद दददद दददद 

(iii) दददद दददद दददद 

(iv) दद दद दद दद दददद दददददद दद ददद दद दददद दददद 

 

शशशशशशश  



दददद ददददद दद दददददद द ददददद दददद ददददद ददददद I 

 

ददददददद दददददददद :- दददद ददददद दद ददददद दद ददददद 

ददददददद ददददददद दददद I 

Maths Study Material 

Learning Objective- To identify and be able to write the name of Quadrilateral.  

To be able to draw and name the parts of a circle.  

 

Quadrilateral- A four sided polygon is called a Quadrilateral. It has four sides and four angles.  

 

 

 

 

 

 

 

 

The Quadrilateral ABCD has four sides AB, BC, CD, DA and four angles A, B, C, D.  

Adjacent sides  AB, BC are adjacent sides.  

Opposite sides – AB and DC are opposite sides.  

A circle is a simple closed curve which is not a polygon.  

The radius is a line segment that connects the centre to a point on the circle.  

Chord is a line connecting two points of a circle.  

Diameter is double the size of the radius.  

 

 

 

 

 



 

 

Activity. To prove that each point on a circle is at an equal distance from the centre 

Material Required- alpins/ Toth picks, A string, Crayon 

Procedure- - Pierce one alpin in on a paper of the notebook. This is the centre of the circle.  

Piece thread with the help of alpin.  

Tie the string to the crayon. Keeping the crayon vertical to the page, take the crayon around the 

alpin.  

You will find that a circle is drawn.  

Assignment 

1.Draw a quadrilateral PQRS. Draw it’s diagonal.. Name them. Is the meeting point of the diagonal in 

the interior or exterior of the Quadrilateral.  

2.Draw sketch of a quadrilateral KLMN . State 

I. Two pairs of opposite sides 

ii. Two pairs of opposite angles 

iii. Two pairs of adjacent sides 

iv. Two pairs of adjacent angles 

3. From the figure identify  

a. The centre of the circle 

b. Three radii 

c. a diameter 

d. a chord     e. a point in the interior 

f. a point in the exterior 

g. A sector   h. a segment 

4. I. Is every diameter of a circle also it’s chord?  

ii. Is every chord of a circle also it’s diameter?  

5. Draw a circle and mark  

. The centre of the circle 

b. Three radii 

c. a diameter 

d. a chord     e. a point in the interior 

f. a point in the exterior 



g. A sector   h. a segment 

6.Write True/False 

a. Two diameters of a circle will necessary intersect.  

b. The centre of a circle is always in its interior.  

 

East Point School 
Science Worksheet 

Class-VI 

Chapter: Getting To Know Plants 

https://youtu.be/9P5yjMeZxqk 

Learning Outcomes: 

• To develop the understanding of different types of plants. 

• To develop the understanding of different parts of plants and their functions. 

1 Introduction 

As we all know, Earth is the only planet in our solar system that has the viable conditions for life to 

exist. While the presence of water and oxygen is the main reason, we must also recognize that life 

would not have been possible if it weren’t for the oxygen-emitting plants, life would not have been 

able to take shape on Earth. These plants are not only our source of oxygen but also the major 

source of the food that we eat. 

2 Herbs, Shrubs and Trees 

We can classify plants on the basis of the thickness of their stems and the place of origin of their 

branches, into three broad categories: 

1. Herbs: These are plants that have green and frail stems. Usually, these are small plants with not 

many branches. Some common examples of herbs are Basil, Coriander, Mint, Oregano, Thyme, 

Parsley, Rosemary etc. 

2. Shrubs: These are plants with hard but not exactly thick stems. Their branches generally 

originate from the base of their stems. These are much taller than herbs but usually shorter than 

trees. Some common examples of shrubs are Aloe Vera, Rose plant, Jasmine plant, Blackberry 

plant etc. 

3. Trees: These are plants which are very tall and have a thick and hard stem. The branches 

originate from the upper part of the tree and are very high above the ground. Some common 

examples of trees are neem, peepal, coconut tree, mango tree etc. 

There are two other kinds of plants which are: 

https://youtu.be/9P5yjMeZxqk


1. Creepers: These are plants which have soft, weak and green stems and hence cannot stand 

straight and instead spread on the ground. Some common examples are sweet potato, 

watermelon, pumpkin etc. 

2. Climbers: These are also plants with soft and weak stems but instead of spreading on the ground 

they take support with a nearby object to climb up. Some common examples of creepers are 

cucumber, bean, grapevine, money-plant etc. 

3 Stem 

The Stem is the part of a plant which is responsible for supplying water to all parts of the plant. It is 

the stem which bears branches, flowers, leaves, fruits and buds. The root sucks the water and 

minerals from the soil and it is the stem’s function to push this water upward to other parts of the 

plant. 

We can observe this by soaking the stem of a plant in a glass with water. On adding coloured ink to 

the water, we observe that after a while the stem and leaves of the plant start to turn the colour of 

the ink, which is proof that the stem carries the water to the different parts of the plant. 

4 Leaf 

4.1 Parts of a Leaf 

1. Petiole: This is the stalk via which the leaf is joined to the plant. 

2. Lamina: This is the expanded part or the green portion of any leaf which is responsible for 

photosynthesis. 

3. Veins: The many lines that run through the surface of the leaf are called veins and the design 

made by them is called leaf venation. They transport water and minerals. 

4. Midrib: This is the central, prominent thick structure right in the middle of the leaf that helps 

support the leaf and prevent it from breaking. 

 

Figure 1: A labelled diagram of a leaf 



The design made by veins in a leaf is called the leaf venation. There are two types of leaf venation: 

1. Reticulate Venation: Reticulate venation is said to exist when the veins form a net-like shape on 

either side of the midrib. This type of venation is seen to exist in dicots like guava and mango. 

2. Parallel Venation: Parallel venation is said to exist when the veins run parallel to one another. 

This type of venation is seen to exist in monocots like banana, wheat, coconut etc. 

 

 

Figure 2: Parallel and reticulate venation 

 

Test your learning: 

Question 1: What are herbs? 

Question 2: With the help of diagrams, tabulate the differences between a shrub and a tree, based 

on the properties of the stem. 

Question 3: From the members of the various groups given below, find the odd one out: 

(a) Coriander (Dhania), Mint (Pudina), Jamun, Grass 

(b) Rose, Mehndi, Guava, Morepankh 

Question 4: What are climbers and creepers? Give some examples. 

Question 5: Pitcher plant has green leaves which can prepare food by photosynthesis then why 

does it eat insects? 

Question 6: Do you agree that stem is like a two way street? 

Question 7: Draw a labelled diagram of the external structure of a leaf. 

Question 8: What do you mean by: 

(a) Leaf Venation 

(b) Reticulate Venation 



(c) Parallel Venation 

Question 9: Solve the riddles given below: 

(a) I have a green tender stem and I am much shorter than you. Who am I? 

(b) I come out first from the seed when it is soaked in water. I provide anchorage to plants. Who am 

I? Write another function that I perform. 

Question 10: Draw the veins of leaves given in the figure below and write the type of venation: 

 

Question 11: Observe the figure and attempt the questions that follow it.: 

 

(a) Label the parts (i), (ii), (iii) and (iv) in the figure. 

(b) What type of venation does the leaf has? 

(c) What type of venation is seen in grass leaves? 

 

 

Activity: 

Question 1: Follow the following steps to observe the stem’s function: 

• Pour water to fill one-third of a glass. 

• Add a few drops of red ink to the water. 

• Cut the base of the stem of a herb and put it in the glass. 

• Note your observation and repeat the process with different coloured inks. 

Question 2: Put a leaf under a white sheet of paper or a sheet in your notebook. Hold it in place. 

Hold your pencil tip sideways and rub it on the portion of the paper having the leaf below it. Note 

your observation. 



 

                                       

                      दददद - ददददददद  

                         ददददद -VI    

                                                                       

                               Link - https://youtu.be/0yi_qSIC7d8  

                                 

 

https://youtu.be/0yi_qSIC7d8


                     

         

  

 

 

 



 

 

 

 

 



 

            

SST STUDY MATERIAL 

CLASS VI 

Video links- https://youtu.be/m0CTq-9ATu4 

LEARNING OBJECTIVE:- 

Students will be able to- 

 Understand globe as the 3D (three dimensional) model of the earth 

 Know the advantages and disadvantages of globe 

 Understand the concept of latitude and longitude 

KEYWORDS:-  

 Parallels of latitudes- a set of imaginary circles drawn horizontally between the 

North Pole and the South Pole 

https://youtu.be/m0CTq-9ATu4


 Meridians of longitude- a set of imaginary circles drawn vertically between the 

North Pole and the South Pole 

 AM- stands for ante- meridian, i.e., before noon 

 PM- stands for post- meridian, i.e., after noon 

 IST- Indian standard time; the standard time for India 

GLOBE:- 

Globe is a true model (miniature form) of the earth. On the globe, countries, continents and 

oceans are shown in their correct size. Earth spins on its axis once after every 24 hours. 

                  

EQUATOR:- 

The equator represents the zero degree latitude. It is an imaginary line that divides the earth 

into two parts is called equator. The northern half of the earth is known as the Northern 

Hemisphere and the southern half is known as the Southern Hemisphere. 

                  

PARALLELS/ LATITUDE:- 

90° north latitude marks the North Pole and 90 degrees south latitude marks the South Pole. 

All parallels north of the equator are called ‘north latitudes.’ Similarly all parallels south of 

the equator are called ‘south latitudes.’ 



Important latitudes-  

(i) Tropic of Cancer (23 ½ °N) in the Northern Hemisphere 

(ii) Tropic of Capricorn (23½°S) in the Southern Hemisphere 

(iii) Arctic Circle at 66 ½° north of the equator 

(iv) Antarctic Circle at 66½° south of the equator 

                 

HEAT ZONES OF THE EARTH:- 

 

 

 

     

GRID:- 

The parallels of latitudes and meridians of longitude form a network or pattern of lines on 

globes and maps, which cut each other at right angles. Such a network of intersecting lines is 

called a grid. 

WORKSHEET 

I. Tick the correct answer- 

Torrid zone- It lies 

between tropic of cancer 

and tropic of Capricorn.  

 

It receives direct 

sunlight and maximum 

heat 
 

Temperate zone- It lies 

between the tropic of 

cancer and Arctic circle 

in the Northern 

Hemisphere & between 

tropic of Capricorn and 

Antarctic circle in the 

Southern Hemisphere. 

 

It receives slanting sun 

rays. 

 

Frigid zone- It lies 

between the Arctic circle 

and the North pole and 

between the Antarctic 

circle and the South pole.  

 

It receives extreme 

slanting rays of the sun, 

the temperature is 

extremely low and is 

covered with ice. 

 



1. The frigid zone lies near 

(i) the Poles                             (ii) the Equator        (iii) the Tropic of Cancer 

2. The total number of latitudes are 

(i) 360                                       (ii) 180                                             (iii) 90 

3. The Antarctic Circle is located in 

(i) the Northern Hemisphere 

(ii)the Southern Hemisphere 

(iii)the Eastern Hemisphere 

4. Grid is a network of 

(i) parallels of latitudes and meridians of longitudes 

(ii) the Tropic of Cancer and the Tropic of Capricorn 

(iii) the North Pole and the South Pole 

5. 0 degree latitude is known as 

(i) Equator   (ii) prime meridian   (iii) tropic of cancer 

II. Fill in the blanks- 

1. The Tropic of Capricorn is located at_____ latitude. 

2. The Arctic Circle is located in the_____ hemisphere. 

3. _____ heat zone receives the maximum sunlight. 

4. Frigid zone lies between _____. 

5. _____ are equal in length. 

III. State whether true or false. Justify if false- 

1. More than half of India lies in the Frigid Zone. 

2. The Tropic of Capricorn does not pass through India. 

3. The earth rotates from west to east. 

4. The equator is the 0-degree latitude. 

5. The two Temperate Zones maintain a moderate climate. 

IV. Answer the following questions briefly- 

1. Define grid. 

2. Differentiate between torrid zone and frigid zone. 

3. State the advantages of globe. 

4. What is the true shape of the earth? 

5. Describe the parallels of latitude. 

ACTIVITY 

 Draw a diagram of the globe showing the equator, Tropic of Cancer and Capricorn, 

Arctic circle and Antarctic circle. 

OR 

 Draw a diagram showing the 3 heat zones of the earth. 



 
 

 

COMPUTER CH-3 MORE ON MS WORD 

 

Video Link 

Watermark-https://www.youtube.com/watch?v=VmdwXTAWe40 

Line spacing-https://www.youtube.com/watch?v=JEC2nH43LU0 

Applying Watermark in a document: 

A watermark is a picture or text that appears behind a document's contents. ... For instance, a watermark might 

say confidential, urgent, or display a symbolic graphic. Adding a watermark to a Word document is a simple 

process . 

 

 

 

 

 

Steps for adding Watermark: 

1. On the Design tab/Page Layout tab, select Watermark. 

2. In the Insert Watermark dialog, select Text and either type your own watermark text or 
select one, like DRAFT, from the list. Then, customize the watermark by setting the font, 
layout, size, colors, and orientation. ... 

3. Select OK. 

Setting line Spacing: 
 

Line spacing is the distance between lines of text. Loose line spacing can make text much 

more readable, while tight line spacing can fit more text in a space. To change the line 

spacing, select the lines you want to change. Then go to the Home tab and find the line 

spacing button in the Paragraph section. 

https://www.youtube.com/watch?v=VmdwXTAWe40
https://www.youtube.com/watch?v=JEC2nH43LU0


Steps for adding line spacing: 

 

Select the paragraphs you want to change. Go to Home > Line and Paragraph Spacing. 

Choose the number of line spaces you want or select Line Spacing Options, and then select 

the options you want under Spacing. 

 

 

Setting Paragraph Spacing:           

Line spacing determines the amount of vertical space between lines of text in a paragraph. 

By default, lines are single-spaced, meaning that the spacing accommodates the largest font 

in that line, plus a small amount of extra space. Paragraph spacing determines the amount 

of space above or below a paragraph. 

 

To format paragraph spacing: 

1. Select the paragraph or paragraphs you want to format. 

2. On the Home tab, click the Line and Paragraph Spacing command. Click Add Space 
Before Paragraph or Remove Space After Paragraph from the drop-down menu. ... 

3. The paragraph spacing will change in the document. 
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